
BÔI TRƠN CỖ MÁY TÍNH
Quá chán nản với cảnh tượng "chiến mã” Windows khởi động chậm như rùa bò, "cô giao liên"
trình duyệt lê bước nặng nề, "anh lính" Word thường xuyên dở chứng, thậm chí bỗng nhiên "chết
đứng" giữa sa trường! Và đ&oacute
Quá chán nản với cảnh tượng "chiến mã” Windows khởi động chậm như rùa bò, "cô giao liên"
trình duyệt lê bước nặng nề, "anh lính" Word thường xuyên dở chứng, thậm chí bỗng nhiên "chết
đứng" giữa sa trường! Và đó chính là hồi chuông cảnh báo đã đến lúc cần chỉnh đốn lại hệ thống.
Không quá khó! Chỉ với vài phút tinh chỉnh đơn giản, máy tính của bạn lại có thể lao nhanh vun
vút và tiếp tục cuộc chinh chiến.ĐÁNH BÓNG WINDOWSWindows hoạt động ngày càng "ì ạch"
và bạn cần ra tay để vực dậy "phong độ” cho hệ thống. Trước khi tiến hành dọn dẹp hệ thống,
hãy thực hiện quét virus và phần mềm gián điệp. Sau đó, gỡ bỏ các thành phần và ứng dụng
Windows không còn dùng đến cùng những thứ vô ích khác. Hãy đảm bảo bạn có trong tay những
công cụ hiệu quả để phục hồi sinh lực cho máy tính.Loại trừ kẻ xấuHãy bắt đầu bằng việc ghé qua
trang web Windows Update (www.microsoft.com) để đảm bảo bạn có bản sửa lỗi mới nhất cho
hệ điều hành của mình. Kế đến, cập nhật tiện ích chống virus và phần mềm gián điệp hiện có, rồi
tiến hành quét toàn bộ hệ thống với từng công cụ trên. Sau khi thực hiện xong các công việc trên,
hãy ngắt kết nối Internet hoặc mạng nội bộ (nếu có), tắt tính năng tự động bảo vệ của các chương
trình bảo mật. Điều này sẽ giúp bạn dễ dàng hơn trong việc xác định đâu là nguyên nhân làm trì
trệ máy tính.Xóa chương trình không cầnCó rất nhiều ứng dụng cài đặt trước vào máy tính những
chương trình "giúp đỡ” được tự động khởi chạy cùng lúc với quá trình Windows khởi động. Tuy
nhiên, chúng không làm được gì có ích thật sự ngoài việc góp phần tạo nên sự "lộn xộn" cho
Windows.Đầu tiên, hãy gỡ bỏ những thành phần Windows không còn cần thiết. Trong Windows
XP, nhấn chuột vào Start > Control Panel > Add or Remove Programs và chọn mục Add/Remove
Windows Components ở khung cửa sổ bên trái (các bước thực hiện cũng tương tự trong các phiên
bản Windows trước đây). Ví dụ, hai "ứng viên" để loại bỏ là Games (nhấn Accessories and
Utilities > Details > Games > Details, và bỏ chọn những game mà bạn muốn bỏ) và MSN Explorer
(chỉ việc đơn giản bỏ chọn nó rồi làm theo trình hướng dẫn). Sau khi thực hiện xong, nhấn Next
rồi đến Finish.
Bạn có thể gỡ bỏ các ứng dụng một cách an toàn bằng cách sử dụng công cụ Add or Remove
Programs của Control Panel. Tuy nhiên, nếu chương trình đó đi kèm khả năng tự gỡ bỏ cài đặt
(uninstall) thì bạn nên sử dụng tính năng này. Đặt trường hợp chương trình đó vẫn xuất hiện trong
cửa sổ Add or Remove Programs sau khi đã thực hiện các bước trên, hay nếu không hỗ trợ tính
năng tự gỡ bỏ cài đặt thì bạn hãy tìm chương trình đó trong danh sách ở mục "Currently installed
programs". Sau đó nhấn chuột vào nút Remove or Change/Remove và thực hiện theo hướng dẫn.
Một vài chương trình bảo mật chỉ có tùy chọn "Change", đòi hỏi việc gỡ bỏ cài đặt phải được thực
hiện bằng chính công cụ đi kèm chương trình.
 
 
 
 
 
 
 



 
Hình 1: Gỡ cài đặt bằng Add or Remove Programs của Windows.
 
 
 
 
 
Tiếp đến, nhấn Show updates ở đỉnh cửa sổ để xem các bản sửa lỗi (patch) cho Windows và ứng
dụng Office đã được bổ sung vào hệ thống của bạn. Tuy nhiên, nếu bạn xóa một bản sửa lỗi ở
đây thì Windows lại hiểu rằng bạn muốn gỡ bỏ bản sửa lỗi này hơn là xóa chúng. Lưu ý, việc gỡ
bỏ bản sữa lỗi sẽ hết sức nguy hiểm! Còn nếu bạn muốn dọn dẹp các tập tin sao lưu, hãy tham
khảo bài "Dọn sạch đĩa cứng sau khi nâng cấp Windows" (ID: A0503_126).Thỉnh thoảng, một
vài chương trình vẫn tồn tại trong danh sách Add or Remove Programs sau khi chúng đã được gỡ
bỏ khỏi hệ thống. Một số khác vẫn "ngoan cố" chạy một số thành phần và thậm chí biểu tượng
của một số chương trình đã được gỡ bỏ cài đặt có thể tiếp tục xuất hiện trên khay hệ thống.Khi
gặp phải tình huống này, hãy nhấn chuột lại vào nút Remove or Change/Remove. Windows XP
(bản Service Pack 2) có thể nhận biết đây là lần thứ 2 bạn cố thực hiện gỡ bỏ cài đặt này và sẽ tự
động sửa lỗi trên. Nếu vẫn không có gì thay đổi, bạn hãy chuyển Windows sang hoạt động ở chế
độ Safe  Mode:  khởi  động lại  máy,  ấn và giữ phím  và chọn Safe  Mode.  Sử dụng tùy  chọn
Remove/Change trong mục Add or Remove Programs một lần nữa. Và nếu vẫn không thành công,
b ạ n  c ầ n  c h ỉ n h  s ử a  l ạ i  R e g i s t r y  c ủ a  W i n d o w s ,  x e m  h ư ớ n g  d ẫ n  t ạ i
(http://support.microsoft.com/kb/314481).  Ngoài ra,  bạn cũng có thể sử dụng phần mềm
Windows Installer Cleanup Utility (find.pcworld.com/49964) để thực hiện công việc trên dễ dàng
và ít rủi ro hơn.Chặn ứng dụng tự khởi chạy
 
 
 
 
 
 
 
 
Hình 2: Startup Control Panel tắt ứng dụng tự khởi chạy.
 
 
 
 
Một khi đã xóa tất cả các ứng dụng mà bạn không dùng đến, bước kế tiếp cần thực hiện là tìm
kiếm những ứng dụng không cần thiết đang hoạt động ở chế độ nền trên hệ thống. Các quá trình
tự khởi động chính của Windows thường đầy bí hiểm và đóng vai trò rất quan trọng. Ví dụ, bạn
có thể sử dụng tổ hợp phím -- để mở cửa sổ Windows Task Manager và có thể nhận thấy xuất hiện
gần 10 cái tên svchost.exe. Đừng quá lo lắng. Thực chất là svchost.exe là một chương trình "ảo"
có nhiệm vụ chạy một chương trình khác và thường thì có từ 5-6 ứng dụng luôn được thực thi. Nếu
bạn đọc được ở đâu đó rằng hệ thống sẽ hoạt động nhanh hơn nếu tắt đi một trong những dịch vụ



của Windows, thì hãy cân nhắc thật cẩn thận trước khi thực hiện. Bạn phải chắc chắn rằng chúng
thực sự không cần thiết vì nếu xảy ra bất kỳ sự nhầm lẫn nào, hệ thống có thể bị "treo cứng". Để
có thêm thông tin về cách nhận diện các chương trình và dịch vụ của Windows hoạt động trong bộ
nhớ,  bạn  nên  tham  khảo  bài  "Nhận  diện  phần  mềm  gián  điệp  trong  Windows"  (ID:
A0507_128).Ngoài  ra,  bạn  có  thể  sử  dụng  tiện  ích  miễn  phí  Startup  Control  Panel
(www.pcworld.com.vn, ID: 49984), có khả năng hiển thị tất cả ứng dụng tự động khởi động trên
máy tính (ngoại trừ một số ứng dụng thật sự cần che giấu). Sau khi đã tải về và cài đặt tiện ích
này, nhấn chuột vào Start > Control Panel > Startup và chọn một trong những thẻ Startup. Bỏ đánh
dấu chọn đối với những chương trình không cần thiết để ngăn chúng tự khởi chạy trong quá trình
khởi động Windows. Các chương trình bị cấm sẽ xuất hiện trong thẻ Delete, vì thế bạn có thể sử
dụng lại dễ dàng nếu cần.Cuối cùng, nhớ khởi động lại máy sau khi thao tác với Startup Control
Panel để thay đổi các cài đặt trong Windows.
 
 
 
 
 
 
TỐI ƯU MÁY TÍNH XÁCH TAY
 
 
 
 
 
 
Cũng giống với máy tính để bàn, những thứ "lạc xoong" trong máy tính xách tay (MTXT) sẽ tranh
nhau "chén sạch" tài nguyên hệ thống. Bất kỳ những gì không cần thiết sẽ làm giảm thời gian
dùng pin của máy. Với vài "tiểu xảo", bạn có thể làm cho MTXT của mình nhanh và hiệu quả
hơn.Chăm sóc nguồn pinĐối với MTXT, bạn cần lưu ý chọn kế hoạch sử dụng nguồn pin thích hợp
với nhu cầu thực tế. Hãy nhấn Start.Control Panel.Power Options. Bên dưới mục Power Schemes,
chọn giá trị Max Battery và nhấn OK. Cài đặt này sẽ tắt màn hình sau 1 phút và chuyển máy về
chế độ chờ (standby) nếu bạn không sử dụng máy trong vòng 2 phút. Nếu thời gian như vậy là
quá sớm, lặp lại các bước trên và chọn giá trị Portable/Laptop để thiết lập chuyển máy về chế độ
chờ sau 5 phút. Tuy nhiên, lưu ý vài chế độ tiết kiệm pin sẽ làm chậm hoạt động của hệ thống.Một
biện pháp khác để cắt giảm sự tiêu hao nguồn pin ở MTXT là làm mờ màn hình. Không may, mỗi
nhà sản xuất MTXT có một kỹ thuật khác nhau để làm mờ màn hình, vì thế bạn cần tham khảo tài
liệu hướng dẫn sử dụng đi kèm. Bàn phím ở vài MTXT thường có phím tăng/giảm độ sáng màn
hình. Bạn cần thiết lập độ sáng màn hình ở mức tối nhất có thể chấp nhận được và tăng lên từng
nấc một.Ngoài ra, card không dây được tích hợp sẵn trong MTXT cũng tiêu thụ nhiều nguồn điện
khi tìm kiếm các điểm truy cập (access point), vì thế hãy tắt chúng đi khi bạn không cần nối mạng
(nội bộ và Internet). Cạnh đó, những thiết bị sử dụng giao tiếp USB và PC Card cũng cần tắt đi nếu
bạn không dùng chúng.Làm sạch hệ thốngNgoài việc thực hiện theo hướng dẫn được giới thiệu ở
mục "Chặn đứng ứng dụng tự khởi chạy", hãy nhấn phải chuột lên các biểu tượng trên khay hệ
thống và tắt chúng đi nếu thấy những chương trình này không cần thiết. Đừng lo, chúng sẽ tự động



xuất hiện lại ở lần khởi động sau của Windows.Chọn chế độ Standby hay Hibernate?Chế độ chờ
của Windows XP sẽ ngưng hoạt động của đĩa cứng và màn hình, nhưng tất cả những thông tin
trong bộ nhớ máy tính vẫn tồn tại và sử dụng chút ít nguồn pin. Ngược lại, chế độ ngủ đông (hay
còn gọi là Hibernate) lưu mọi thứ vào đĩa cứng và tắt hẳn máy tính. Windows khởi động trở lại
nhanh hơn ở chế độ chờ và chậm hơn nhiều ở chế độ Hibernate. Tuy nhiên, nếu pin của máy tính
hết đột ngột khi đang hoạt động ở chế độ chờ thì bạn sẽ mất đi mọi thay đổi ở những tập tin đang
mở nhưng chưa kịp lưu.Để chuyển máy về chế độ chờ, chọn Start.Turn off Computer.Stand By.
Còn để chuyển máy về chế độ ngủ đông (Hibernate), bạn chọn Start.Turn off Computer và nhấn
Hibernate (bạn có thể phải ấn và giữ phím  để thấy tùy chọn này). Nếu không tìm thấy mục
Hibernate, bạn chọn Start.Control Panel.Power Options và đánh dấu tùy chọn Enable hibernation.
Để khởi động lại hệ thống ở một chế độ khác, nhấn vào nút tắt/mở nguồn trên máy.Nếu MTXT của
bạn có một nút nhấn mang tên "Sleep" hay có khả năng tự động tắt máy khi gập nắp lại thì bạn
nhấn chuột vào thẻ Advanced trong cửa sổ Power Options để tìm tùy chọn điều chỉnh lại những cài
đặt này ở mục Power Buttons.
 
 
 
 
 
 
Tối ưu đĩa cứngCàng nhiều không gian đĩa cứng trống thì Windows càng vận hành hiệu quả,
chẳng hạn khi dùng đĩa cứng làm bộ nhớ ảo (virtual memory). Bạn có thể tham khảo bài "Để PC
chạy nhanh hơn" trên TGVT A 12/2001, tr. 94 để biết những biện pháp tinh chỉnh thông số bộ
nhớ Windows. Thật may, việc dọn dẹp đĩa cứng thường được thực hiện một cách dễ dàng. Ví dụ,
một vài người cần không gian đĩa cứng mà Windows sử dụng cho tính năng Recycle Bin (mặc
định là 10% dung lượng đĩa cứng). Để tiết kiệm, nhấn phải chuột lên biểu tượng Recycle Bin, chọn
Properties, kéo thanh trượt xuống mức 3% hay thậm chí thấp hơn, sau cùng nhấn OK. Một ứng
dụng khác chiếm khá nhiều không gian đĩa cứng là System Restore của Windows. Để hạn chế sự
phí phạm này, nhấn phải chuột lên biểu tượng My Computer, chọn Properties > System Restore,
kéo thanh trượt xuống mức 3% (hay thấp hơn) rồi nhấn OK.
 
 
 
 
 
 
 
 
Hình 3: Giải phóng đĩa cứng bằng cách giảm dung lượng lưu trữ của Windows System Restore.
 
 
 
 
Đến lúc này, bạn có thể chạy tiện ích Disk Cleanup của Windows: nhấn Start > Run, gõ vào lệnh



cleanmgr /sageset:99 và ấn . Chọn từng loại tập tin mà bạn muốn tìm kiếm và nhấn OK. Nhấn
phải chuột lên ổ đĩa cứng C: trong cửa sổ My Computer và chọn Properties > Disk Cleanup. Bạn sẽ
thấy một danh sách tập tin mà bạn có thể xóa. Hãy chọn những mục mà bạn thấy không còn cần
thiết, nhấn OK rồi đến Yes.Tuy nhiên, bạn cũng có thể giữ lại vài mục trong danh sách đó. Ví dụ,
nội dung của thư mục Temporary Internet sẽ giúp tăng tốc trình duyệt Internet Explorer nhờ giảm
số lần tải dữ liệu của một trang web mà bạn thường xuyên truy cập. Ngoài ra, nếu xóa các tập tin
Office Setup thì vài tính năng nâng cấp của bộ ứng dụng văn phòng Office 2003 sẽ không hoạt
động chính xác.Một khi bạn đã "phát quang" hoàn toàn đĩa cứng, hãy khởi động lại máy. Tại
màn hình Windows, nhấn chuột phải lên ổ đĩa cứng C: trong cửa sổ My Computer và chọn
Properties > Defragment Now. Trong hộp thoại Defragmenter, nhấn Analyze. Nếu được thông
báo cần thực hiện "dồn đĩa", hãy nhấn nút Defragment và chờ đợi. Trên thực tế, có vài bất đồng
về khả năng nâng cao hiệu quả hoạt động của hệ thống sau khi thực hiện dồn đĩa. Tuy nhiên,
nhiều ý kiến đồng tình rằng việc dồn đĩa định kỳ sẽ giúp truy xuất dữ liệu nhanh hơn.Dọn dẹp
RegistryBạn chắc chắn sẽ mất rất nhiều thời gian để "đánh vật" với những khóa Registry, thông số
cache cùng vô số chi tiết khác trong quá trình tối ưu hệ thống của mình. Tuy nhiên, bạn có thể tận
dụng những tiện ích sẵn có để thực hiện công việc này như Power Tools (30 USD, bản dùng thử có
thể tải về tại find.pcworld.com/49980) và System Mechanic của hãng Iolo Technolohies (50 USD,
bản dùng thử có thể tải về tại find.pcworld.com/49982). Cả hai tiện ích này giúp dễ dàng quét
sạch những thứ "thừa thãi" trong Registry. Hạn chế người dùngHãy cố giữ Windows luôn "an
toàn" bằng cách tạo thêm một tài khoản người dùng giới hạn. Tài khoản này thường được áp
dụng cho những ai sử dụng chung máy tính với bạn nhưng không tạo được sự tin tưởng về những
gì  họ  sẽ  cài  đặt  trên  máy  tính.  Trước  hết,  đăng  nhập  vào  hệ  thống  với  quyền  quản  trị
(administrator) và nhấn Start > Control Panel > User Accounts > Create a new account (nếu không
thấy tùy chọn này, người quản trị hệ thống mạng có thể đã giới hạn hệ thống của bạn). Nhập vào
tên tài khoản người dùng mới, nhấn Next và đánh dấu tùy chọn Limited bên dưới mục "Pick an
account type" rồi nhấn Create Account. Để tạo mật khẩu (password) cho một tài khoản, nhấn
chuột lên tài khoản đó và chọn Create a password. Sau đó, gõ vào mật khẩu (2 lần) và câu gợi ý
tìm lại mật khẩu (password hint), sau đó nhấn Create Password. Cuối cùng đóng hộp thoại User
Accounts một khi đã hoàn tất. TĂNG TỐC ỨNG DỤNG Không sớm thì muộn, mỗi ứng dụng sẽ
tích tụ "hàng đống" những thứ không cần thiết như các tập tin "rác", các công cụ bổ sung cũ rích
hay những cài đặt khác làm cản trở khả năng "tác chiến" của bạn. Hồi sức cho Microsoft WordBất
cứ khi nào gặp sự cố như "treo máy" chẳng hạn, phần mềm xử lý văn bản Microsoft Word đều
lưu lại những tập tin tạm trong đĩa cứng, thường có tên như "DFC15F8.TMP". Việc sử dụng tiện
ích Disk Cleanup có thể giải quyết vấn đề này, nhưng bạn cũng có thể xóa chúng. Để bắt đầu, hãy
đóng tất cả chương trình đang chạy. Sau đó, nhấn Start.Search và chọn All files and folders (nếu
cần thiết), nhập vào ~*.tmp trong hộp thoại có nhãn "All or part of a file name", chọn Local Hard
Drives (C:) bên dưới mục "Look in" và nhấn Search. Khi việc tìm kiếm hoàn tất, ấn tổ hợp phím -A
để chọn tất cả tập tin và rồi ấn .Mặc định, Word lưu bản sao AutoRecover của các tập tin đang
mở sau mỗi 10 phút. Khi gặp sự cố, Word cung cấp khả năng khôi phục lại các tập tin đang mở
ngay trước đó. Thỉnh thoảng, các tập tin AutoRecover tồn tại trên đĩa cứng lâu hơn thời gian cần
thiết, nhằm đề phòng những rủi ro có thể xảy ra. Để đảm bảo những tập tin AutoRecover "cũ rích"
này không chiếm dụng đĩa cứng, mở phần mềm Word và chọn Tools > Options > File Locations.
Nhấn đúp vào mục AutoRecover files, sau đó là nhấn phải chuột lên tên thư mục xuất hiện (thường
là \Word\STARTUP) và chọn Explorer. Tiếp đến, chuyển đến thư mục cha của thư mục hiện hành



và hãy xóa tất cả những tập tin có phần mở rộng là .asd.Các công cụ bổ sung (add-in) "lỗi thời"
cũng có thể làm chậm tốc độ xử lý của Word. Để giải quyết vấn đề trên, chọn Tools > Templates
and Add-ins, tìm những bổ sung không còn cần dùng đến trong danh sách "Global templates and
add-ins" và nhấn Remove để loại bỏ chúng.Nếu nút Remove bị "mờ" đi, đóng Word lại và mở thư
mục Word Startup (thường nằm ở thư mục C:\Documents and Settings\username\Application
Data\Microsoft\Word\Startup, với username là tên tài khoản đăng nhập hệ thống của bạn). Hãy
đổi tên của mỗi tập tin không cần thiết đó để chúng không tồn tại ở dạng .dot (ví dụ như đổi tên
tập tin oldmarcos.dot thành oldmacros.dot.save). Khi khởi động lại Word, những add-in "vô ích"
trên sẽ không còn được kích hoạt.Quét dọn OutlookMột điểm nổi bật ở tiện ích gửi nhận thư điện
tử và quản lý danh bạ liên lạc Microsoft Outlook là khả năng lưu trữ mọi thứ chỉ trong một tập tin
có phần mở rộng là .pst. Tuy nhiên, điều bất cập ở đây là gần như không thể và rất khó để "làm
sạch" tập tin này.Tập tin .pst của Outlook 2003 đáng tin cậy hơn so với các tập tin ở phiên bản
Outlook 97, 2000 và 2002. Nếu nâng cấp lên Outlook 2003 từ một phiên bản trước đây, có thể
bạn vẫn đang sử dụng tập tin .pst cũ. Việc cập nhật sang định dạng của Outlook 2003 có thể giúp
bạn lưu lại nhiều thông tin trước đây. Tuy nhiên, để thực hiện công việc này thường tốn nhiều thời
gian.
 
 
 
 
 
 
 
 
4: Tăng tốc Outlook bằng cách nén tập tin .pst.
 
 
 
 
Để xác định loại tập tin .pst nào của Outlook 2003 đang sử dụng, nhấn phải chuột vào mục
Personal Folders ở khung cửa sổ bên trái bên dưới mục All Mail Folders, chọn Properties for
Personal Folder, và nhấn Advanced. Nếu hộp thoại Format xuất hiện thông tin "Personal Folders
File (97-2002)" thì có nghĩa bạn đang sử dụng phiên bản cũ. Để chuyển đổi, đóng Outlook và tìm
kiếm  tập  tin  outlook.pst  hay  mailbox.pst.  Hai  tập  tin  này  thường  được  lưu  tại  thư  mục
C:\Documents and Settings\username\Application Data\Microsoft\Outlook, với username là tên
tài khoản đăng nhập hệ thống của bạn.Nếu không tìm thấy hai tập tin trên, mở Outlook và nhấn
File > Data File Management.  Khi  đó, một hộp thoại liệt  kê thông tin về thư mục Archive và
Personal Data sẽ xuất hiện. Tiếp đến, nhấn vào Settings để xem đường dẫn của chúng hay chọn
Open folders để hiển thị nội dung trong cửa sổ tiện ích Explorer. (Bạn cần đóng Outlook trước khi
thực hiện các bước sau). Một khi đã tìm được tập tin mong muốn, nhấn chuột phải lên tập tin đó
và chọn Rename để tiến hành đổi tên (ví dụ là outlook.old.pst).Khi khởi động lại Outlook, chương
trình sẽ thông báo không thể tìm thấy tập tin .pst và bạn hãy nhấn OK. Outlook sẽ đề nghị tạo một
tập tin Personal Folders mới và bạn cần chọn Open và kế đến là OK. Khi Outlook hoàn tất, nhấn
File > Open > Outlook Data File, chọn tập tin outlook.old.pst ở trên (hay mailbox.old.pst) và nhấn



OK một lần nữa. Khi này, khi nhấn chuột vào dấu cộng (+) ở mục Personal Folders ở khung cửa sổ
bên trái, bạn sẽ tìm thấy tất cả những dữ liệu của Outlook cũ. Nhấn chuột và kéo những phần mà
bạn muốn giữ lại từ những thư mục này sang các thư mục Inbox, Contacts, Calendar, Sent Items
hay thậm chí cả thư mục Deleted Items. Bạn có thể để mục Personal Folders trong trạng thái mở,
hoặc nhấn chuột phải lên đó và chọn Close để đóng lại. Đặt trường hợp nếu Outlook không nhận
ra danh sách Contact, bạn có thể tham khảo hướng dẫn tại find.pcworld.com/49988 để khắc
phục.Bạn có thể cải thiện hiệu quả hoạt động của bất kỳ phiên bản Outlook nào bằng cách nén
(archive) các thư cũ: nhấn File > Archive và chọn một thư mục, xác định thông tin ngày tháng ở
trình đơn thả xuống "Archive items older than" và nhấn OK. Ngoài ra, bạn ghé qua địa chỉ
find.pcworld.com/49989 để biết cách thức thiết lập Outlook tự động sao lưu.Kế đến, chạy công
cụ Inbox Repair Tool của Outlook để chắc chắn tập tin .pst hoạt động tốt. Khi đã đóng Outlook,
nhấn Start.Search và chọn All files and folders (nếu cần thiết), gõ vào scanpst.exe và ấn . Nhấn
đúp chuột lên tập tin trong cửa sổ kết quả tìm kiếm và nhấn Browse, xác định tập tin .pst mô tả ở
trên và chọn tập tin đó. Tiếp đến, nhấn Open > Start. Nếu hộp thoại Repair Tool phát hiện được
lỗi, chọn Make backup of scanned file before repairing và nhấn Repair. Cuối cùng, nhấn OK khi
công việc hoàn tất.
 
 
 
 
 
 
 
Hình 5: Thu lại dung lượng đĩa cứng dành cho tập tin tạm của tiện ích Internet Explorer.
 
 
 
 
Tiếp tục công việc, bạn nhấn phải chuột lên mục Personal Folders, chọn Properties for Personal
Folders, nhấn nút Advanced dưới thẻ General và chọn Compact Now. Khi công việc kết thúc, nhấn
OK hai lần.Tăng tốc trình duyệt
Việc dọn dẹp các tập tin tiền sử (history), thông tin cookie và lưu tạm (cache) của tiện ích Internet
Explorer có thể được thực hiện rất đơn giản: nhấn Tools > Internet Options và chọn Delete Cookies
và Delete  Files  (ở mục Temporary Internet  Files)  hay Clear History (ở mục History)  trong thẻ
General.Nếu máy tính của bạn được trang bị đĩa cứng 150GB thì không có vấn đề gì nếu trình
duyệt Internet Explorer sử dụng 3GB để lưu các tập tin tạm. Ngược lại, bạn có thể phải chấp nhận
tốc độ duyệt web chậm hơn một chút để tiết kiệm không gian cho đĩa cứng dung lượng 10GB. Để
cắt giảm sự phí phạm đĩa cứng này, nhấn Tools > Internet Options, chọn Settings ở thẻ General và
điều chỉnh thanh trượt xuống mức 20GB hay 30GB chẳng hạn (hay bạn cũng có thể tăng con số
này lên để tăng tốc khi duyệt web với kết nối quay số). Nhấn OK hai lần để kết thúc.  
 
 
 
 



 
 
VỆ SINH MÁY TÍNH
 
 
 
 
 
 
Bên cạnh các yếu tố "ảo" làm chậm khả năng hoạt động của Windows như thiếu bộ nhớ, hết đĩa
cứng và nhiều thứ linh tinh khác trong hệ điều hành thì bụi bẩn đóng trên bàn phím, con chuột,
màn hình hay thậm chí cả trên đĩa quang chính là những yếu tố "thật" góp phần không nhỏ cản
trở thao tác người dùng trên máy tính.Bàn phímChắc chắn, bụi bẩn "cư trú” lâu ngày trong bàn
phím làm cho việc đánh máy trở nên khó khăn hơn. Để lau dọn bàn phím, bạn sẽ cần chuẩn bị
một bình xịt hơi, một lọ cồn isopropyl (thường được bán ở nhà thuốc tây), tăm cotton thấm nước
và khăn mềm.Tháo bàn phím ra khỏi máy và đem ra ngoài (hay đặt trên một tờ giấy báo cũng
được), lật ngược bàn phím và gõ nhẹ nhàng để bụi văng ra. Tiếp đến, dựng đứng bàn phím và
thổi không khí vào giữa các phím. Cuối cùng, tiếp tục lật ngược bàn phím, lắc và gõ vào các phím
ấn. Hãy lặp lại 3 ba thao tác: xịt - lắc - gõ cho đến khi không còn bụi.Với bàn phím vẫn chưa
được cắm vào máy tính, thấm một ít cồn isopropyl vào khăn và lau trên bề mặt bàn phím. Sau đó,
hãy sử dụng một tăm cottom (cũng đã được thấm cồn) để lau các khe giữa những phím ấn. Cồn
isopropyl bốc hơi nhanh nhưng nếu cần, bạn có thể dùng khăn khô để lau lại bàn phím.ChuộtNếu
"chú chuột" máy tính dùng bi xoay (không phải chuột quang) của bạn trở nên "đỏng đảnh", hãy
vệ sinh các thanh cuộn bên trong nó. Tất cả những gì bạn cần là một bình xịt không khí và một cái
kẹp.Tháo chuột ra khỏi máy và lật ngược nó. Bạn sẽ thấy một đĩa bằng nhựa nhỏ với một lỗ tròn ở
giữa. Vặn đĩa này theo chiều mũi tên được chỉ định, gỡ đĩa nhựa và lấy bi xoay ra.Bạn sẽ thấy 2
hay 3 thanh cuộn bên trong. Bụi và chất xơ bám trên các thanh cuộn này chính là nguyên nhân
gây ra những "hành vi" khó hiểu khi bạn di chuyển chuột. Xịt không khí vào những thanh cuộn
này, rồi lôi các chất xơ ra ngoài bằng tay hoặc kẹp. Lau sạch bi xoay và gắn chuột lại hiện trạng
ban đầu.Màn hìnhBạn không thể đọc được vài ký tự trong bảng tính phải chăng vì chúng là ký
hiệu đặc biệt? Không, đó là do bụi bám trên bề mặt màn hình. Lau một màn hình CRT rất dễ dàng:
chỉ cần tắt màn hình và lau bằng khăn ẩm mềm (dùng nước, không được dùng nước lau kính).Tuy
nhiên, lau bụi trên màn hình LCD phức tạp hơn đôi chút. Bạn cần một khăn bằng chất liệu sợi nhân
tạo như khăn lau  kính  đeo mắt,  một  lọ  chất  lỏng gồm một  nửa là  nước và  một  nửa là  cồn
isopropyl. Tắt màn hình (hay tắt máy nếu là máy tính xách tay), lau cẩn thận và nhẹ nhàng bề mặt
màn hình bằng khăn ẩm đã thấm dung dịch chất lỏng trên. Với cả màn hình CRT và LCD, hãy chờ
vài phút sau khi lau trước khi bật lại màn hình.Đĩa quangChỉ cần một vết bẩn nhỏ trên bề mặt đĩa
CD/DVD sẽ làm gián đoạn một bản nhạc, đoạn phim hay quá trình cài đặt phần mềm. Nếu lau
nhẹ nhàng mặt đĩa từ trong ra ngoài với một khăn cotton khô sẽ không giải quyết được vấn đề.
Khi ấy, bạn hãy sử dụng thiết bị lau đĩa quang là Scotch CD and CD-ROM Cleaner của hãng 3M
(13USD, find.pcworld.com/49992). Thiết bị quay tay này đi kèm một bình xịt nước lau đĩa. Cho
một ít chất lỏng lên bề mặt đĩa dơ, đặt đĩa (nhãn đĩa hướng xuống) vào thiết bị, đóng nắp lại và
xoay tay quay 5 lần. Sau đó, lấy đĩa ra và để khô trong vài phút.
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